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View Group access

The View Groups Tool Box is accessed
from the pull-down menu Tools > Tool
Boxes > View Groups, and depending on
the selected options to display, the tool box
may resemble the following:

(It is “undocked” below, therefore displaying the title bar.)
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The View Groups Tool Box is commonly
docked at the lower left corner of the
MicroStation window, as shown below.
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Chapter 21 — Automation Tools Instructions Section 21A-01 — CPN Data Placement

View Groups vs. Models

Even though some people use the View Group selection box to change models, View Groups are
not Models, and Models are not View Groups, and they should not necessarily be used
interchangeably. View Groups store much more information than just the model name, therefore,
using the View Group selection box to change models may or may not produce the anticipated
results.

HEE & s| s

View Groups Models

The “MicroStation” method of creating a new model, and View Group

When the MicroStation Create a new model tool is used, as shown at
the right, (which we don’t use), the Create Model dialog displays,
which is partially shown below, right. At the lower left corner of the
Create Model dialog, the check-box, (M), option exists to Create a

T Create a new modsl
View Group at the same time the model is created. If this option is 1 P —— /
checked, a View Group will be created with the same name as the F‘*

) Models

new model, with a suffix of “Views”. \‘J 'wu,m.cb?
Zn Ew\! o

Also, when using the MicroStation Create a new model tool, the %Qan Ay n*a/nmta“m

option exists to use either a separate seed-file or to use the current \

open model as the seed-file. In either case, the window attributes of Crate a Wiew Group

the selected option will become the window attributes of the new View [] Create Link %

Group.

The “Design” method of creating a new model, and View Group

In Design, the Create New Model command is
accessed through Geopak D&C Manager, as

(50 Design and Computation Manager |Z||E|E|
shown at the right. File Edit Settings Favarites
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When the “Design” Create New Model (= Manipulate Files, Models Levels
command is used, a View Group is created Backup
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Chapter 21 — Automation Tools Instructions Section 21A-01 — CPN Data Placement

View Groups

A view group is a set of view window layouts applicable to a model within the open DGN file. View
groups make it easy to access and navigate through different models, with different view group
configurations for different design purposes. View groups let you set up your view window
preferences including the number of open views, view size, and orientation. A view group definition
also includes the attributes for each view and the level display settings.

Using view groups, you can quickly change from one configuration to another. For example, while
sheeting P&P sheets, you might prefer to arrange the views with one overall “fit view”, and three
separate smaller views for Plan, Profile, and DBG information, as shown at the left, below. However,
when working in the Plan or Profile area, you might prefer two larger views, as shown on the right,
below. Creating separate View Groups allows for the quick and consistent window configuration
changes.
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NOTE: When you save settings (File > Save Settings), view groups that have changes are saved.

To create a View Group when not creating a model

1. Set up the view windows in your preferred view windows configuration.

2. Access the Manage View Groups dialog
from the Manage view Groups icon, as
shown at the right.

view Groups =

Q- © - M - EENEIGER 2/ EE

3. Click the Create View Group icon.

! Manage oup ! -
e 2™ X
M4 Create View Group Description Model -]
T CPH [E] County Project Mumber
T pL_0050_012 four views [E] ML_0050_ 02
T bAL_0050_012 Tw “With rasters |8] ML_0050_012
T Project Overview Diefault viewgroup for ... [&] Project Overview
M SR NNAN Views [l SR NNAN test o
[ LCloze ] [ Apply ]
T_hls opens the Create View Group dialog, as shown at the S ERieW eyl o
I'Ight. Creating
. . todel:  WL_0050 012
4. Complete the Name and Description fields, shown at the | |
right. The Model with which this View Group is associated e
already is noted on the dialog box. Descripton: | |
. . . Ok, Canicel
5. Click OK. The new view group is created.
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To change the active View Group

From the View Groups window's option btz (i 5]
menu, select a different view group, as O-0-M°-
shown at the right.

: Rl BB EEEHE

Or, in the Manage View Groups dialog box, select the View Group and click Apply (or simply
double-click the required view group). Your screen will update to show the new display
configuration.

To modify a View Group

1. Inthe View Groups window, click the ew Group
Manage View Groups icon. R 7= i 0050 012 D 1 EEAEEE
~Tanage ew Groups

)
g

The Manage View Groups dialog box opens.

2. Select, (highlight), the desired View
Group name and click the Edit View
Group Properties icon.

ME'mEiEt:Iit View Group Properties escription Model o
T CPH [&] County Project Mumber
T ML_0050_01 i [E rL_0050_ 02

[T 1L_0050_01: 8] ML_0050_012

T Project Overview Diefault viewgroup for ... [ Project Overview
F SRONNSN Wiews [E1 SR NNRN - test 4
[ Close ] [ Apply ]
The View Group Properties dialog box opens, as shown
at the right. View Group Properties
Froperties
3. Make the appropriate changes to the Name and Name:! | NN
Description. Diescription: | With rasters |
4. Click OK.

[ Or ] [Cancel]

To delete a View Group

1. Inthe View Groups window, (as shown above in the T .
Modify View Group discussion), click the Manage View  [EttaeUt R URSHUTT
Groups icon. The Manage View Groups dialog opens,
(as shown at the right).

2. Select the required view group.

3. Click the Delete View Group icon, (the red “X"). = ML 0050 012 Temp Views

The highlighted view group will be deleted.

Page 4 of 4


mk:@MSITStore:C:\Program%20Files\BentleyXM\Documentation\MicroStation.chm::/ustnhelp173.html#nowhere#nowhere�
mk:@MSITStore:C:\Program%20Files\BentleyXM\Documentation\MicroStation.chm::/ustnhelp173.html#nowhere#nowhere�

Chronology of Changes to Design Manual Section:

021C-055 View Groups vs Models

6/30/2010 Revised
Added Index and updated format



	21C-55
	Iowa Department of Transportation
	Office of Design
	Automation Tools Instructions
	Chapter 21
	Design Manual
	21C-55

	View Groups vs. Models

	rpt_ChangesPerSection
	rpt_ChangesPerSection



<<

  /ASCII85EncodePages false

  /AllowTransparency false

  /AutoPositionEPSFiles true

  /AutoRotatePages /All

  /Binding /Left

  /CalGrayProfile (Gray Gamma 2.2)

  /CalRGBProfile (sRGB IEC61966-2.1)

  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)

  /sRGBProfile (sRGB IEC61966-2.1)

  /CannotEmbedFontPolicy /Warning

  /CompatibilityLevel 1.5

  /CompressObjects /All

  /CompressPages true

  /ConvertImagesToIndexed true

  /PassThroughJPEGImages true

  /CreateJobTicket false

  /DefaultRenderingIntent /Default

  /DetectBlends true

  /DetectCurves 0.1000

  /ColorConversionStrategy /sRGB

  /DoThumbnails false

  /EmbedAllFonts true

  /EmbedOpenType false

  /ParseICCProfilesInComments true

  /EmbedJobOptions true

  /DSCReportingLevel 0

  /EmitDSCWarnings false

  /EndPage -1

  /ImageMemory 1048576

  /LockDistillerParams false

  /MaxSubsetPct 100

  /Optimize true

  /OPM 1

  /ParseDSCComments true

  /ParseDSCCommentsForDocInfo true

  /PreserveCopyPage true

  /PreserveDICMYKValues true

  /PreserveEPSInfo false

  /PreserveFlatness true

  /PreserveHalftoneInfo false

  /PreserveOPIComments false

  /PreserveOverprintSettings true

  /StartPage 1

  /SubsetFonts true

  /TransferFunctionInfo /Apply

  /UCRandBGInfo /Remove

  /UsePrologue false

  /ColorSettingsFile ()

  /AlwaysEmbed [ true

  ]

  /NeverEmbed [ true

    /Arial-Black

    /Arial-BlackItalic

    /Arial-BoldItalicMT

    /Arial-BoldMT

    /Arial-ItalicMT

    /ArialMT

    /ArialNarrow

    /ArialNarrow-Bold

    /ArialNarrow-BoldItalic

    /ArialNarrow-Italic

    /CenturyGothic

    /CenturyGothic-Bold

    /CenturyGothic-BoldItalic

    /CenturyGothic-Italic

    /CourierNewPS-BoldItalicMT

    /CourierNewPS-BoldMT

    /CourierNewPS-ItalicMT

    /CourierNewPSMT

    /Georgia

    /Georgia-Bold

    /Georgia-BoldItalic

    /Georgia-Italic

    /Impact

    /LucidaConsole

    /Tahoma

    /Tahoma-Bold

    /TimesNewRomanMT-ExtraBold

    /TimesNewRomanPS-BoldItalicMT

    /TimesNewRomanPS-BoldMT

    /TimesNewRomanPS-ItalicMT

    /TimesNewRomanPSMT

    /Trebuchet-BoldItalic

    /TrebuchetMS

    /TrebuchetMS-Bold

    /TrebuchetMS-Italic

    /Verdana

    /Verdana-Bold

    /Verdana-BoldItalic

    /Verdana-Italic

  ]

  /AntiAliasColorImages false

  /CropColorImages true

  /ColorImageMinResolution 150

  /ColorImageMinResolutionPolicy /OK

  /DownsampleColorImages true

  /ColorImageDownsampleType /Bicubic

  /ColorImageResolution 150

  /ColorImageDepth -1

  /ColorImageMinDownsampleDepth 1

  /ColorImageDownsampleThreshold 1.50000

  /EncodeColorImages true

  /ColorImageFilter /DCTEncode

  /AutoFilterColorImages true

  /ColorImageAutoFilterStrategy /JPEG

  /ColorACSImageDict <<

    /QFactor 0.76

    /HSamples [2 1 1 2] /VSamples [2 1 1 2]

  >>

  /ColorImageDict <<

    /QFactor 0.76

    /HSamples [2 1 1 2] /VSamples [2 1 1 2]

  >>

  /JPEG2000ColorACSImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 15

  >>

  /JPEG2000ColorImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 15

  >>

  /AntiAliasGrayImages false

  /CropGrayImages true

  /GrayImageMinResolution 150

  /GrayImageMinResolutionPolicy /OK

  /DownsampleGrayImages true

  /GrayImageDownsampleType /Bicubic

  /GrayImageResolution 150

  /GrayImageDepth -1

  /GrayImageMinDownsampleDepth 2

  /GrayImageDownsampleThreshold 1.50000

  /EncodeGrayImages true

  /GrayImageFilter /DCTEncode

  /AutoFilterGrayImages true

  /GrayImageAutoFilterStrategy /JPEG

  /GrayACSImageDict <<

    /QFactor 0.76

    /HSamples [2 1 1 2] /VSamples [2 1 1 2]

  >>

  /GrayImageDict <<

    /QFactor 0.76

    /HSamples [2 1 1 2] /VSamples [2 1 1 2]

  >>

  /JPEG2000GrayACSImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 15

  >>

  /JPEG2000GrayImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 15

  >>

  /AntiAliasMonoImages false

  /CropMonoImages true

  /MonoImageMinResolution 1200

  /MonoImageMinResolutionPolicy /OK

  /DownsampleMonoImages true

  /MonoImageDownsampleType /Bicubic

  /MonoImageResolution 1200

  /MonoImageDepth -1

  /MonoImageDownsampleThreshold 1.50000

  /EncodeMonoImages true

  /MonoImageFilter /CCITTFaxEncode

  /MonoImageDict <<

    /K -1

  >>

  /AllowPSXObjects true

  /CheckCompliance [

    /None

  ]

  /PDFX1aCheck false

  /PDFX3Check false

  /PDFXCompliantPDFOnly false

  /PDFXNoTrimBoxError true

  /PDFXTrimBoxToMediaBoxOffset [

    0.00000

    0.00000

    0.00000

    0.00000

  ]

  /PDFXSetBleedBoxToMediaBox true

  /PDFXBleedBoxToTrimBoxOffset [

    0.00000

    0.00000

    0.00000

    0.00000

  ]

  /PDFXOutputIntentProfile (None)

  /PDFXOutputConditionIdentifier ()

  /PDFXOutputCondition ()

  /PDFXRegistryName ()

  /PDFXTrapped /False



  /CreateJDFFile false

  /Description <<





    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e55464e1a65876863768467e5770b548c62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200036002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>

    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc666e901a554652d965874ef6768467e5770b548c52175370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200036002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>

    /CZE <>

    /DAN <>

    /DEU <>

    /ESP <>

    /ETI <>

    /FRA <>







    /HUN <>

    /ITA (Utilizzare queste impostazioni per creare documenti Adobe PDF adatti per visualizzare e stampare documenti aziendali in modo affidabile. I documenti PDF creati possono essere aperti con Acrobat e Adobe Reader 6.0 e versioni successive.)

    /JPN <>

    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020be44c988b2c8c2a40020bb38c11cb97c0020c548c815c801c73cb85c0020bcf4ace00020c778c1c4d558b2940020b3700020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200036002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>

    /LTH <>

    /LVI <>

    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken waarmee zakelijke documenten betrouwbaar kunnen worden weergegeven en afgedrukt. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 6.0 en hoger.)

    /NOR <>

    /POL <>

    /PTB <>





    /SKY <>



    /SUO <>

    /SVE <>

    /TUR <>



    /ENU (Use these settings to create Adobe PDF documents suitable for reliable viewing and printing of business documents.  Created PDF documents can be opened with Acrobat and Adobe Reader 6.0 and later.)

  >>

>> setdistillerparams

<<

  /HWResolution [600 600]

  /PageSize [612.000 792.000]

>> setpagedevice




[image: image2.wmf]

  Chapter 21 ( Automation Tools Instructions

Section 21A-01 ( CPN Data Placement


[image: image3.png]





Chapter 21 ( Automation Tools Instructions

Section 21A-01 ( CPN Data Placement


[image: image4.png]3 N

iAd ";mm\

ale 3 View Group

] Create Link. %









[image: image5.png]Bl Edt Settings Favortes

i B¢ =%
(B> Design Files

B Sample Plan
£ AlFis
ODAC Taoks
B Instuuctions
3 CPN Tools
3 Genera Tooks
Maripulate Elements.
£ Moripuste Fes, Models Levels
B Backup
B Level Match
B Levels_Tum Ori Off M





[image: image6.png]Fle Edt Eement Setngs Toos Uities Workspace Applcations Window RasterPathCorrection Bidltems telp &xiom

AT T Hame: Regon
nput: Region
pit: None Selected|
e Image Capture

50

=

X[

3

IR P

Q- O -\ - )| o | B slslelsl ;X [sizzens Y [EEwan i

iy comiete I 0 b I





[image: image7.png]2! Wi Highway) utomationSection\Test\DLO\9701203099\Design\97012018.dsn, ML_0050_012 (2D - V8 DGN) - MicroStation V8 XM Edition,
Edt Hement setings Todk Lbites Workspace fpplcations Widow RestepahCorection Bidtens telp paon - [E] - 5 - =3~ 2 - <t @
vIE 4~ o VB VER) TG TOG.
W R W e

10
R R EFIERE T
~ ! r

T I

%) View 2 - ML_0050_012
EEEEEEFFEEEIEEE E

AR

38

IR P

Q-O-\ -@ o e [Bslalsslzs) ;X [ Y, [uzzes Ji

[ — i T [@ [uasa | I





[image: image8.png](<4

A -2

| MiEfa sl zls




[image: image9.png]



[image: image10.png]View Groups

v Previous odel
v Next o
v Ao e
v e

[ Manage viw rous
v iow Toages

Show &l
Lt

fc BBl 1o

5]




[image: image11.png]X
0-0-\-@ JEILs[slel7|o




[image: image12.png]Desciption Model A

B

County Project Number
IE2 ML_0050_012 four views

ML_0050_012

22 Project Overview
JFs SR A Vs

Defauit viewgioup for Fisject Dverview

SR TN test ]

——




[image: image13.png]Create View Group
Ciealing
Model: ML_0050_012

Hlams!

Desciptor:





[image: image14.png]53]
Q-0 -\-@ v%uqu







Index



View Group Access


View Groups vs. Models


The “MicroStation” method of creating a new model, and View Group


The “Design” method of creating a new model, and View Group


View Groups



To create a View Group when  not creating a model



To change the active Vew Group



To modify a View Group



To delete a View Group

_____________________


View Group access
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The View Groups Tool Box is accessed from the pull-down menu Tools > Tool Boxes > View Groups, and depending on the selected options to display, the tool box may resemble the following:  


(It is “undocked” below, therefore displaying the title bar.)
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The View Groups Tool Box is commonly docked at the lower left corner of the MicroStation window, as shown below.
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Right-clicking within the View Groups tool box shows the available “display options”, as shown below.


View Groups vs. Models 

Even though some people use the View Group selection box to change models, View Groups are not Models, and Models are not View Groups, and they should not necessarily be used interchangeably.  View Groups store much more information than just the model name, therefore, using the View Group selection box to change models may or may not produce the anticipated results.  
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The “MicroStation” method of creating a new model, and View Group
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When the MicroStation Create a new model tool is used, as shown at the right, (which we don’t use), the Create Model dialog displays, which is partially shown below, right.  At the lower left corner of the Create Model dialog, the check-box, ((), option exists to Create a View Group at the same time the model is created.  If this option is checked, a View Group will be created with the same name as the new model, with a suffix of “Views”.


Also, when using the MicroStation Create a new model tool, the option exists to use either a separate seed-file or to use the current open model as the seed-file.  In either case, the window attributes of the selected option will become the window attributes of the new View Group.


The “Design” method of creating a new model, and View Group 



In Design, the Create New Model command is accessed through Geopak D&C Manager, as shown at the right.


When the “Design” Create New Model command is used, a View Group is created automatically, and the Project Overview model is used as the seed-file, or template.


View Groups

A view group is a set of view window layouts applicable to a model within the open DGN file. View groups make it easy to access and navigate through different models, with different view group configurations for different design purposes. View groups let you set up your view window preferences including the number of open views, view size, and orientation. A view group definition also includes the attributes for each view and the level display settings.


Using view groups, you can quickly change from one configuration to another.  For example, while sheeting P&P sheets, you might prefer to arrange the views with one overall “fit view”, and three separate smaller views for Plan, Profile, and DBG information, as shown at the left, below.  However, when working in the Plan or Profile area, you might prefer two larger views, as shown on the right, below.  Creating separate View Groups allows for the quick and consistent window configuration changes.




NOTE: When you save settings (File > Save Settings), view groups that have changes are saved.


To create a View Group when not creating a model


1. Set up the view windows in your preferred view windows configuration.


2. Access the Manage View Groups dialog from the Manage view Groups icon, as shown at the right.


3. Click the Create View Group icon.



This opens the Create View Group dialog, as shown at the right.

4. Complete the Name and Description fields, shown at the right.  The Model with which this View Group is associated already is noted on the dialog box.


5. Click OK.   The new view group is created.


To change the active View Group


From the View Groups window's option menu, select a different view group, as shown at the right.


Or, in the Manage View Groups dialog box, select the View Group and click Apply (or simply double-click the required view group).  Your screen will update to show the new display configuration.


To modify a View Group

1. In the View Groups window, click the Manage View Groups icon.



The Manage View Groups dialog box opens.


2. Select, (highlight), the desired View Group name and click the Edit View Group Properties icon.



The View Group Properties dialog box opens, as shown at the right.


3. Make the appropriate changes to the Name and Description.


4. Click OK.


To delete a View Group




1. In the View Groups window, (as shown above in the Modify View Group discussion), click the Manage View Groups icon.  The Manage View Groups dialog opens, (as shown at the right).


2. Select the required view group.


3. Click the Delete View Group icon, (the red “X”).


The highlighted view group will be deleted.
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